CAKRAWALA PENDIDIKAN
FORUM KOMUNIKASI ILMIAH
DAN EKSPRESI KREATIF ILMU PENDIDIKAN
CAKRAWALA PENDIDIKAN
Forum Komunikasi Ilmiah dan Ekspresi Kreatif Ilmu Pendidikan
Terbit dua kali setahun pada bulan April dan Oktober
Terbit pertama kali April 1999

Ketua Penyunting
Kademi

Wakil Ketua Penyunting
Syaiful Rifa’i

Penyunting Pelaksana
Djuwenti
Bambang Tumoyo
Udin Erawanto
HMA Prawoto

Penyunting Ahli
HM Zainuddin
Mastruri
Karyati
Nurhadi

Pelaksana Tata Usaha
Yunus
Nandir
Suroardi

Alamat Penerbit/Redaksi: STKIP PGRI Blitar, Jalan Kalimantan No. 49 Blitar, Telepon (0342)801493. Langganan 2 nomor setahun Rp 10.000,00 ditambah ongkos kirim Rp 3.000,00. Uang langsung dapat dikirim dengan wesel ke alamat Tata Usaha.


DAFTAR ISI

Peningkatan Profesionalisme Guru di Abad 21 ........................................... 1
Feri Huda

Penilaian Pembelajaran Berbasis Kompetensi dalam Rangka Meningkatkan Kemampuan Belajar Siswa ....................................................... 10
Ekbal Santoso

Efektifitas Belajar Matematika Sambil Bermain ........................................... 18
Cicik Pramesti

Menumbuhkan Minat Belajar Pelajaran Matematika pada Siswa Madrasah Tsanawiyah .......................................................... 26
Suryanti

Menyelesaikan Soal Kelipatan dan Faktor dari Dua Bilangan Cacah melalui Pembagian Bilangan Prima .................................................. 35
Mohamad Khafid Irsyadi

Teknik-teknik Penjumlahan, Pengurangan dan Perkalian Bilangan ........ 43
Kristiani

The Use of Dialogue, Discussion, and Role Playing in Teaching English Speaking ................................................................. 51
M. Alimulhuda

Syntax in Computer Operating Directions ................................................. 62
R. Hendro Prasetyanto

Interaksi Pembelajaran Matematika Dengan Portfolio dan Motivasi Siswa terhadap Hasil Belajar Matematika Siswa di SMP ..................... 73
Suryo Widodo
SYNTAX IN COMPUTER OPERATING DIRECTIONS

R. Hendro Prasetyanto

Abstract: This paper presents an analysis of syntactical structures used in computer-operating directions. The analysis is aimed at helping both common readers and students of English understand the directions well. The theory underlying the analysis comprises Nelson’s, Hockett’s, Downing’s, and O’Grady’s concept of English syntax, and Jackson’s idea of English phrases and clauses. Based on the analysis, the writer found the following findings. First, imperatives play a dominant role in computer operating directions. The imperatives are composed of infinitive without to followed by direct object and adverb. The direct object is in the form of noun phrase. Second, all the directions begin with to-infinitive with direct object as adverb of purpose. Third, the tense used is simple present because a direction deals with future activity. The idea of future in English is not always expressed in simple future tense. Next, the sentence length of the directions depends much on the phrases and vocabulary used. Most of the phrases are in the form of noun phrases. One important thing to keep in mind is that to understand computer-operating directions the knowledge of English syntax is inadequate. Mastery of the meaning of certain terms is of great importance too.

Key words: syntax, direction, computer

This paper deals with the problem of syntax as it is used in computer operating directions. What is meant by syntax here is forms of linguistic components which serve to build any statements. The phrase computer operating refers to the activity of carrying out the computer programs which are actually activities to be done in order to run the computer. The term directions which equals
in meaning to *petunjuk menjalankan perintah* in Indonesian is part of linguistic domain. In the following paragraphs the three key words are treated subsequently.

Every language has rules of syntax, and to the linguist the essential rules are descriptive as in descriptive linguistics. They are the rules which underpin the life of the language and which are extremely slow to change. In addition, the rules indicate the way ideas or concepts in one language are expressed. Every language has different rules of arrangement due to the features of the language.

Gleason (1961: 3), a descriptive linguist, gives an example of these rules by stating that

Speech as an orderly sequence of specific kinds of sounds and sequences of sounds. It is orderly in terms of a very complex set of patterns which repeatedly recur and which are at least partially predictable. These patterns form the structure of expression, one major component of language in the sense that the linguist uses the term.

It should be noted here that the same principle is applied to other components of language like morphology and syntax. Therefore, Gleason (1961:3) said further that

the structure of content, the second major component of language constitute recurrent patterns. The content includes ideas, social situations, meanings, the facts or fantasies about man's existence, the things man reacts and tries to convey to his fellows.

Theoretically, as most grammarians hold, syntax is the grammatical arrangement of words in a sentence. The arrangement is generally termed word order and agreement in the relationship between words in a sentence. So syntax is primarily concerned with structure of sentences. The basic question in syntax is how words are organized so as to convey certain ideas. Different arrangement may yield different ideas. But sometimes it may hold the same concept or meaning.

O'Grady and Dobrovolsky hold an opinion that *language is a highly structured system of communication* (1989: 126). With this in mind they define syntax as the system of rules and categories that allows words to be combined to form sentences. When the system is violated, the verbal or written expressions are meaningless or sound awkward. The following examples show how
the system is applied and sometimes manipulated with spoiling the meaning.

(1) The cat sat on the mat.
(2) My old brown leather suitcase.
(3) The cat on the mat sat.
(4) My brown leather old suitcase.

Sentences (1) and (2) follow normal English word order or arrangement, while sentences (3) and (4) violate it. Why is it so? Word order in English is very important because the language is no longer inflected. Changes to conventional system are tolerated in such literary works as poems and drama to create dramatic, poetic or comic effect like in (5). In Latin, however, word order is of secondary value since every Latin word is inflected - declined or conjugated. The word endings or suffixes determine the meaning. In analyzing Latin expression the smart analysis is focussed on word endings regardless of word position in a sentence.

(5) “I’ll sing to him, each spring to him
And long for the day when I’ll cling to him,
Bewitched, bothered and bewildered am I.”

A normal sentence in English usually contains at least three basic elements, that is, subject, verb, and object. The three grammatical positions may be occupied by respective nouns or pronouns, verbs, and nouns or pronouns. These categories show a kind of relationship among them. Therefore, syntax only refers to the relationship between the grammatical components of language in use. The relationship does of course include semantic aspect. This relationship which can be expressed in many ways like in (6) and (7) is the province of syntax.

(6) A woman was run over in central London today by a vehicle travelling at high speed.
(7) A vehicle travelling at high speed ran over a woman in central London today.

Jackson (1982: 86) extends the three basic components into seven types of clause.

The division is based on the types of verb used in every sentence (clause). A clause consisting of subject and intransitive verb with or without an adjunct is classified as an intransitive clause type 1 and 2 respectively, as in sentences (8) and (9). A clause which has as the verb linking verb is grouped as an intensive clause type like in sentence (10). Types 4 and 5 consist of subject, transi-
tive verb, and object with or without adjunct. Type 6 is a clause which contains two direct object, while type 7 is a clause composed of subject and transitive verb followed by direct object and object complement as in sentences (11) and (12).

(8) The dog barked.
(9) A policeman lives in that house.
(10) That sounds a good idea.
(11) They passed Aunty Ann the salt.
(12) We imagined Uncle Bill much fatter.

As language is composed of certain categories, the analysis is centered upon the identifying and dissecting of those categories. According to O’Grady and Dobrovolsky (1989) there are three syntactic categories: lexical categories, phrasal categories, and clausal categories. Lexical categories are called parts of speech in grammar. In syntax the relationship among lexical categories is manifested in phrasal and clausal categories.

In phrase discussion the point is about noun phrase and verb phrase. In grammar, however, the discussion covers adjective and adverb phrases. Noun phrase and verb phrase are the dominant components in analyzing syntactic relations in a sentence. Sentence (13) which is taken from O’Grady and Dobrovolsky (1989: 135) can be analyzed in this way.

(13) The player lost a shoe in the dugout.

---

**Diagram 1**

*A Top Down Analysis of Sentence*
At a higher level where an expression is a compound or complex sentence, this kind of analysis can still be applied as in sentences (14) and (15).

(14) Bob likes to play soccer but he does not have the opportunity.
(15) Although Jim finds the work difficult, he continues to do his best.

METHOD OF ANALYSIS

This study is of qualitative nature. In qualitative study the data are in the form of utterances or written statements (Djojosuroto and Sumaryati, 2004: 17) In linguistic point of view the statements are composed of sentences, each of which is built upon phrases and clauses. These components can be identified and so analyzed. In order to do some analysis of the statements several steps are taken. First, the data are systematically presented for the sake of ease. The sentences which have the same construction are grouped, and the rest are classified in another group. Second, the grouped sentences are dissected into phrases. Third, after the identification of their features, the reduction is done. In qualitative study this activity is called data reduction. Next, to verify the chipping certain theories of English phrases and clauses are applied. This activity is called data validation. Drawing conclusion is the last process in analyzing the data.

In details the dissecting of syntactic components follows a top down description. The description is represented by a model of tree diagram where hierarchical analysis suits. The flowchart of this abstract description is as follows:

Unit 1 : sentence
Constructed from : noun phrase followed by a verb phrase
Unit 2 : noun phrase
Constructed from : proper noun or determiner followed by a noun
Unit 3 : verb phrase
Constructed from : verb or verb followed by a noun phrase
Unit 4 : determiner
Examples : a or an, the
Unit 5 : noun
Example : player, man
Unit 6 : verb
Example : lost, to change

(16) To change the color of text, click Font on the Format menu, and then click the Font tab.
(17) To create Superscript on subscript text, select the text and press CTRL + PLUS SIGN or CTRL + EQUAL SIGN.
(18) To add hidden text to a document, select the text and press CTRL + SHIFT + H.
(19) To see the hidden text, click the Show/Hide button.
(20) To slant, arch, and stretch words, click object on the Insert menu, click the Create New Tab, and then click Microsoft WordArt.
(21) To see a document as it will print, click the Print Preview button. Press ESC to return to draft view.
(22) To move a toolbar button, press ALT while dragging the button. To copy a button, press ALT + CTRL.
(23) To display the name of a toolbar button, point to the button.
(24) To copy the formatting of selected text multiple times, double-click the Format Painter Button.
(25) To increase or decrease the size of selected text press CTRL + J or CTRL + [.
(26) To go to the beginning or end of a document, press CTRL + HOME or CTRL + END.
(27) Slide Finder is most useful in slide sorter view, where you can easily rearrange slides after you insert them.
   To switch to slide sorter view, click slide sorter on the View menu.
(28) To lift a document to the width of your screen, click the Zoom Control box, and then click Page Width.
(29) To apply the Normal Style to a selected paragraph, press CTRL+SHIFT+N.
(30) To insert page numbers at the outside margin, click Page Numbers on the Insert Menu, and then click Outside in the Alignment box.

FINDINGS OF THE STUDY

The result of the analysis shows that the pattern of computer operating directions falls into two types. The first type as shown in figure 2 begins with to-infinitive phrase. This phrase can be completed with noun phrases as direct objects or with adverbs if the verbs are intransitive like go. The second type starts with a complex sentence serving as introduction to the problem. Then, the construction of the first type follows (see figure 3).

<table>
<thead>
<tr>
<th>To-Infinitive + DO</th>
<th>Imperatives.</th>
</tr>
</thead>
<tbody>
<tr>
<td>To-infinitive + Adverb.</td>
<td>Imperative.</td>
</tr>
</tbody>
</table>

**Figure 2**
**Pattern of the First Type**
Figure 3
Pattern of the Second Type

(31) To add hidden text to a document, select the text and press CTRL + SHIFT + H.
(32) To see the hidden text, click the Show/Hide button.
(33) To open the Go to dialog box, double-click the page-number area on the status bar.

Sentences (31), (32) and (33) are different from the pattern in figure 3 but the same as that in figure 2. To-infinities in figure 3 show some purpose of the activities select and click. The rest of the samples follow the pattern in figure 2.

DISCUSSION OF THE DATA

The analysis of the fifteen Englisah imperatives is based on the theory of syntax discussed previously. The analysis begins with the search for phrasal category and then clausal category. Phrasal categories in the fifteen imperatives are classified according to the types of phrases and their functions in a sentence.

Table 4
Phrasal Categories as Direct Objects

<table>
<thead>
<tr>
<th>No</th>
<th>Phrasal Category</th>
<th>Example</th>
<th>Components</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Noun Phrase</td>
<td>Hidden text</td>
<td>Participle.Noun</td>
</tr>
<tr>
<td>3</td>
<td>Noun Phrase</td>
<td>Objects</td>
<td>Plural Noun</td>
</tr>
<tr>
<td>4</td>
<td>Noun Phrase</td>
<td>A document</td>
<td>Det.Noun</td>
</tr>
<tr>
<td>5</td>
<td>Noun Phrase</td>
<td>The formatting of the selected text</td>
<td>Det.Gerund.Prepp.NP.</td>
</tr>
<tr>
<td>6</td>
<td>Noun Phrase</td>
<td>Microsoft WordArt</td>
<td>Name. CompoundNoun.</td>
</tr>
</tbody>
</table>
Table 5
Phrasal Categories as Adverbs or Adjuncts

<table>
<thead>
<tr>
<th>No</th>
<th>Phrasal Category</th>
<th>Example</th>
<th>Components</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Noun Phrase</td>
<td>To a document</td>
<td>Prep.Det.Noun</td>
</tr>
<tr>
<td>3</td>
<td>Noun Phrase</td>
<td>To draft review</td>
<td>Prep.NounPhrase</td>
</tr>
<tr>
<td>4</td>
<td>Noun Phrase</td>
<td>In slide sorter view</td>
<td>Prep.NounCompoundNoun</td>
</tr>
<tr>
<td>5</td>
<td>Noun Phrase</td>
<td>To the width of your screen</td>
<td>Prep.Det.Noun, Prep.NounPhrase</td>
</tr>
<tr>
<td>6</td>
<td>Noun Phrase</td>
<td>In the Alignement box</td>
<td>Prep.Det.NounPhrase</td>
</tr>
</tbody>
</table>

The phrasal categories which serve as the direct objects are exemplified in all the imperatives. They are shown in table 4. The other phrasal categories which serve as adverbs or adjuncts are shown in table 5.

Another phrasal category is verb phrase. It begins with to-infinitive plus direct object or adjunct. This phrasal category serves to explain or limit the information contained in the main clause. This phrasal category functions as adverb of purpose.

Adverbs of purpose can be expressed in various ways. Sentences (34) and (35) express a purpose by means of a clause marker so that and in order that plus a clause. Sentence (36) also expresses a purpose but by means of the preposition for. Unlike the previous sentences, sentence (37) uses to-infinitive to express a purpose.

(34) Fasten the sunshade securely, so that it won’t blow away.
(35) In order that no mistakes should be made, everyone was informed by letter.
(36) He is studying for a degree.
(37) The team is training to win.

With reference to the kinds of expression of purpose, the findings show that sentence (37) is the model for computer-operating directions treated here.

Another point worth discussing here is the use of imperative mood in computer-operating directions. Mood is the form of the verb which indicates the speaker’s attitude toward his own statement. Buckler and Avoy (1960:101) state that imperative sentences belong to rhetorical types of sentences. They express a command as in sentence (38). Besides, imperative sentences express
a request and exhortation as in sentences (39) and (40).

(38) Shut the door.
(39) Please permit him to attend.
(40) Let us pray.

According to Downing and Locke (1992:193) typically an imperative has no subject. When a subject is added, the result is a marked form, namely, words or pronouns of interjection, which is of vocative case in Latin, as in sentences (41) and (42). The remarked form can also be expressed by means of mood tag or question tag as in sentences (43) and (44).

(41) God. fastinate to help me in troubles.
(42) Don’t you say a word.
(43) Do come in, won’t you?
(44) Let’s have a swim, shall we?

Sentence (45) constitutes an example of computer-operating direction. The sentence is composed of to-infinite (followed by a noun phrase as a direct object) functioning as an adverb of purpose, and an imperative. According to Downing and Locke the basic structure of imperative is of two types as in figure 6 below. Sentences (46), (47), (48) are the examples of type 1 while (49) and (50) are the examples of type 2.

(45) To check the spelling of a document, press F7.

(1) Predicator + Complement + Adjunct
    Residue

(2) Predicator + Complement + Adjunct + Mood Tag
    Residue

**Figure 6**
Basic Imperative Structure

(46) Stop at the traffic lights!
(47) Be careful!
(48) Pass me the scissors!
(49) Wait a moment, will you?
(50) Do come in, won’t you?
With reference to figure 6 all the samples treated in this paper follow the model of imperatives proposed by Downing and Locke but only type 1 is applicable. Sentences (51) and (52) represent the model.

(51) To lift a document to the width of your screen, click the Zoom Control box, and then click Page Width.
(52) To apply the Normal Style to a selected paragraph, press CTRL+SHIFT+N.

CONCLUSIONS

After the treatment of all the samples under the theory of syntax, especially imperatives, we can come to a conclusion that the computer-operating directions (COD) are suited to the theory of syntax. The general word order of the directions can be diagrammed as in figure 7. Further research is badly extended with other data of different sources to complete the results of this research, and to have an overall view of the concept of impoeratives in English.

Another point worth mentioning here is that to understand computer-operating directions one should learn not only their syntax but also their technical terms used to express certain ideas. Therefore, another research on vocabulary used in computer-operating directions is badly required.

Adverb of Purpose, + Infinitive + Noun Phrase

Figure 7
Word Order of COD

REFERENCES
